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1 FT9xx Toolchain Introduction

The free FT9xx toolchain is a port from the popular GNU toolchain which includes the following
components:

e GCC based compiler
e GNU Binary Utilities (binutils) based tools, most notably:
o as - the assembler
o Id - the linker
o and some other useful tools such as objdump, ar, ranlib, addr2line, etc.
e GDB based debugger
e In addition, a plugin for the Eclipse IDE is also provided. This plugin allows the FT9xx
toolchain to integrate seamlessly into Eclipse and as a result, greatly simplifies the
development works for the FT9xx MCUs.

1.1 Compiler: ft32-elf-gcc

The FT9xx compiler is used similarly to standard GCC. It supports most GCC options such as -Wall,
-01, -02...

Example: To compile a C file into an object file:

ft32-elf-gcc -c -o file.o file.c

1.2 Assembler: ft32-elf-as

The FT9xx assembler functions in the same way as the standard GNU assembler (GAS). The
assembly files should be written using the GAS general syntax.

Example: To compile an assembly file into an object file:

ft32-elf-as -o file.o file.s

1.3 Linker: ft32-elf-Id

Typically running behind ft32-elf-gcc, the FT9xx linker performs two tasks. It first links all object
files and libraries into a.out and then convert’s a.out into an executable file for FT9xx. Similar to
the FT9xx compiler and assembler, the FT9xx linker supports most standard GNU linker options.

Example:
e To link various object files / libraries into an .elf file:
ft32-elf-gcc -nostartfiles filel.o file2.0 -L <libfolder> -l lib1 -I lib2 -o file.elf
e To convert file.elf into a FT9xx binary file, which can be programmed into the chips:

ft32-elf-ld --oformat binary -o file.bin file.elf
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1.4 Debugger: ft32-elf-gdb

The Bridgetek programmer/debugger module is needed for the communication between ft32-elf-
gdb and the chip. The communication follows the GDB remote protocol. In addition to the
debugger module, two software components are needed:

e GDB Bridge: for converting GDB commands into the debugger module commands
e Bootloader: for receiving & executing the debugger module commands

More information on how to use the FT9xx debugger can be found in section 5.1.3 of this
document.

1.5 A useful utility: ft32-elf-objdump

ft32-elf-obj dump displays various information about object files. Its usage is the same as
standard GNU objdump.

Example: To disassemble file.elf into a text file

ft32-elf-objdump -d file.elf > disassembly.txt
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2 Setting up the FT9xx Toolchain

2.1 Installing the toolchain

The toolchain can be installed by running the setup wizard “FT9xx Toolchain Setup_version.exe”,
which can be downloaded from the Bridgetek website. Please follow the steps in the wizard to

complete the installation process. It is recommended to use the default settings for simplicity.

Note: all applications should be closed before the installation or a restart may be required.

I Froo: Toolchain Setup )
< Bridgetek

ERIDGING TECHNOLOGY

Welcome to the FT9xx Toolchain Setup Wizard

This wizard will guide you through the installation of the FT9xx Toolchain.

It is recommended that you dose &ll other applications before continuing. This will make
it possible to update relevant system files without having to reboot your computer.

Click Mext to continue.

Mext = Cancel

Figure 1 Toolchain Setup Wizard Dialog box

In the License Agreement dialog box, click I Agree.

% FT9xx Toolchain Setup [PESEEm——)

License Agreement
Please review the license terms before instaling the FTSwx Toolchain. B rl d g ete k

BRIDGING TECHNOLAGY

Press Page Down to see the rest of the agreement.

[FTQxx Toolchain Licensing Information

GINU Binutils is distributed under the GNU GPL License.

GNU Compiler Collection (GCC) is distributed under the GNU GPL
License.

GINU Debugger (GDB) is distributed under the GNU GPL License.

GINU Make and GNU Coreutils are distributed under the GNU GPL
License.

The Cwvowin T T < and lhraries are distribited nnder the GNTT GPT s

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install the FT9xx Toolchain.

< Back [ I Agree [ Cancel

Figure 2 License Agreement Dialog box

Product Page
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Go through the Revision and Release information and click Next.

o -

Revision and Rel i K -
View information about the revisions of components induded in the FT9xx Toolchain. ‘ B rl d g ete k

*
" BRIDGING TECHNOLOGY

Press Page Down to see the rest of the Revision and Release Information.

Release Information

This is Release 2.3.@ of the FT9xx Toolchain for Windows,

comprising the command-line teools (GCC, GNU Binutils, GDB), the
Eclipse IDE and the drivers needed to start development. A set
of examples are included to demenstrate how to use the drivers.
Projects created with the Bridgetek Eclipse plugin are compiled

using a Makefile. Therefore, the latest versicn of some
necessary GnuWin32 utilities (make and coreutils) are also
included.

This toclchain adds support for the FT93@ series of
Microcontrollers.

Revision Informaticn

This information can also be found in Release Notes. bt in your installation directory.

e [

Figure 3 Revision and Release Information Dialog box

Select the Components and click Next.

- ——

Choose Components ,0’ -
Choose which features of the FT9xx Toolchain you want to install, B rl d g ete k

*
O\ BRIDEING TECHNOLOGY

Check the components you want to install and unchedk the components you don't want to install.
Click Next to continue.

rDescription

= Position your mouse aver a
Edlipse IDE for FT9xx component to see its

External Utiities description,
GnuWin32 Make 3
GruWin32 Corelti
Java 8 Update 12
| Python 2.7.10

MCCI USE Stack Tools
FT9x Driver Library 5
FT9xx Example Applic:
Update PATH variable
Create icons on desktr

Select components to install:

Space required: 736.9MB

Figure 4 Components Dialog box
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Click Browse and select a different file path for the FT9xx Toolchain installation. Alternately,
continue installing in the specified folder by clicking Next.

% oereorer s T ==

Choose Install Location ’o’ =
Choose the folder in which to install the FT9xx Toolchain. ,.‘ B rl d g ete k
)
*

ERIDGING TECHNOLOGY

Setup will install the FT9xx Toolchain in the following folder. To install in a different folder, dick
Browse and select another folder. Click Next to continue.

"Desﬁnaﬁon Folder

Space required: 591.3MB
Space available: 46, 2GB

’ < Back ” Mext = ]

Figure 5 FT9xx Toolchain Install Location Dialog box

Click Browse and select a different file path for installing FT9xx examples and documents.
Alternately, continue installing in the specified folder, by clicking Install.

. - ——

Choose Install Location ’o’ -
Choose the folder in which to install the FT9xx Toolchain. ,.‘ B rl d g ete k
*
-

BRIDGING TECHNOLOGY

Flease select the installation folder for the FT9xx examples and documents,

: \Users\govind. mukundan \Documents \Bridgetek \FT9::40.0. 1

"Fl'gxx Examples and Documents Installation Folder

Space required: 591.3MB
Space available: 46.2GE

o [

Figure 6 FT9xx Toolchain-Examples & Documents Install Location Dialog box
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The FT9xx Toolchain installation progress bar is displayed.

-~ wyeepmea

*
*
*

Installing
Please wait while the FTSxx Toolchain is being installed.

Bridgetek

*
¢, ERIDGING TECHNOLOGY

*
L

Extract: hashtable.h

Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:

thread... 100%
tuple... 100%:
type_traits... 100%
typeindex... 100%
typeinfo... 100%
unordered_map... 100%:
uniordered_set... 100%
utility... 100%
valarray... 100%
variant... 100%
vector... 100%

Qutput folder: C:\Program Files'Bridgetek\FT9xx Toolchain{Toolchaintools\ft32-elfiindud...

Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Futrart:

auto_ptr.h... 100%
backward_warning.h... 100%
binders.h... 100%
hash_fun.h... 100%
hash_map... 100%
hash_set... 100%

hachtahla h

’ < Back H Mext > ]

Cancel

Figure 7 FT9xx Toolchain - Installation Progress Window

If Java is selected for installation, the
Applications and click OK

following message is displayed. Please close any open Java

Installing R =
Please wait while the FT9xx Toolchain is being installed. P, rl g ete
*eN ERIDGING TECHNOLOGY
Extract: jre-8u121-windows-586.exe
Qutput folder: C:\Program File: nuWin32\shareloca...
Qutput folder: C:\Program File ouiin hareloca...
areVoca
arelloca
arelloca
@ Setup will now run the Java Runtime (JRE) Installer. Please close any
W' openJava Applications (like Eclipse) before proceeding. areloca
arelloca
arelloca
arelloca
arelloca
arelloca
QOutput folder: C:\Program Files\Bridgetek \FT9xx Toolchain\External\GnuWin32\shareYoca. ..
Qutput folder: C:\Program Files\Bridgetek \FT9xx Toolchain\External\GnuWin32
Qutput folder: C:\Program Files\Bridgetek \FT9xx Toolchain\External\Javag
Extract: jre-8u121-windows-586.exe =
[ <eo ][ wot> |

Figure 8: Close any running Java Applications before launching JRE Installer
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Setup will then launch the JRE installer and the following window will be displayed
™
—_ L=

’
Java Setup - Welcome

Welcome to Java

Java provides access to a world of amazing content. From business
solutions to helpful utilities and entertainment, Java makes your Internet

experience come to life.

Mote: Mo personal information is gathered as part of our install process
Click here far more information on what we do collect.

Click Install to accept the license agreement and install Java now.

Install = ]

Click Install

[] change destination folder [ Cancel ] i
——————————————————
Figure 9 Java Setup Window

and follow the instructions to install Java on the machine.

r
Java Setup - Welcome

Status: Installing Java

3 Billion

Devices Run Java
:-E';]ava" #1 Development Platform m

During installation, if a Python 2.7.10 Setup dialog box is displayed, select the appropriate

option as required and click Next.

Figure 10 Java Setup Progress Window

9

Copyright © Bridgetek Pte Ltd

Product Page
Document Feedback


http://brtchip.com/m-ft9/
mailto:docufeedback@brtchip.com?subject=Document%20Feedback:%20AN_325%20Version%201.04

TECHNOLOGY

 Bridgetek

BRIDGING

Application Note

AN_325 FT9xx Toolchain Installation Guide

Version 1.04

Document Reference No.: BRT_000116 Clearance No.: BRT#074

2 Python 2.7.10 Setup

et

python

flll’
windows

Select whether to install Python 2.7.10
for all users of this computer.

() Install just for me (not available on Windows Vista)

Back [ Next > ] [ Cancel

Figure 11 Python Setup Dialog box

Select a different Destination Directory to setup Python. Alternately, continue installing in the

specified folder by clicking Next.

Figure 12 Destination Directory Selection Dialog box for Python Setup

Select the Python features to be installed or continue with the default features and click Next.

) Python 2.7.10 Setup

[ |

b

python

fl W

windows

Select Destination Directory

Please select a directory for the Python 2.7.10 files.

£ Python27 -

|C:\Python27\,

<Back [ Next> ] [ cancel |
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1 Python 2.7.10 Setup

===

Customize Python 2.7.10

Select the way you want features to be instaled.
Click on the icons in the tree below to change the
way features wil be installed.

»

Register Extensions
Tl Tk
Documentation
Utility Scripts

pip .
Test suite

m

Add mudbboe maen do Dodb

python

for

windows

[ Disk Usage ] [ Advanced ]

Python Interpreter and Libraries

This feature requires 25MB on your hard drive. It
has 6 of 7 subfeatures selected. The subfeatures
require 30MB on your hard drive.

[ < Back ][ Mext = ] [ Cancel ]

Figure 13 Python Features Customization Dialog box
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Python installation progress bar is displayed.

4 Python 2.7.10 Setup

Install Python 2.7.10

several minutes.

Please wait while the Installer installs Python 2.7.10. This may take

Status: Copying new files

Figure 14 Python Installation Progress Dialog box

Click Finish to complete the Python installation.

4 Python 2.7.10 Setup

===

python

f--r
windows

Complete the Python 2.7.10 Installer

Special Windows thanks to:
Mark Hammond, without whose years of freely
shared Windows expertise, Python for Windows
would stil be Python for DOS.

Click the Finish button to exit the Installer.

Figure 15 Python Installation Completion Dialog box
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The FT9xx Toolchain installation is continued.

% FTox Toolchain Setup

Installing K> =
Please wait while the FT9xx Toolchain is being installed. B rl d g ete k

*
.0' BRIDGING TECHROLOGY

Extract: structboms__scsi_ c_r_b_ inquiry__t.himl
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract:
Extract: structboms__command_block_wrapper__t.html... 100%%
Extract: structboms__command_status_wrapper__t.html... 100%
Extract: structboms__scsi_ c_d_b__inquiry__t.html... 100%
Extract: structboms__scsi___c_d_b__mode__sense__t.html... 100%%
Extract: structboms_ scsi_ ¢ d b_ read_ capadty_ t.himl... 100%
Extract: structboms__scsi_ c_d_b_ read_ format__capadty_ t.himl... 100%
Extract: structboms__scsi_ c_d_b_ read_ t.html... 100%
Extract: structboms__scsi_ c_d_b_ removal__t.himl... 100%
Extract: structboms__scsi_ c_d_b_ request_ sense__t.html... 100%
Extract: structboms__scsi_ b_ test  unit_ ready_ t.html... 100%

Extract: structboms__scsi_ c_d_b_ write_ t.html... 100%
Fvtrarts atriirthame  ersi h inauire t bl

] ]

Figure 16 FT9xx Toolchain - Installation Progress Window

Select the Open AN_325 checkbox to start immediately after closing the Setup Wizard. Else leave
it unchecked. Click Finish to complete the FT9xx Toolchain Setup.

I FTo Toolchain Setap [ e )

4 Bridgetek

.0
*
'0. ERIDGING TECHROLOGY

Completing the FT9xx Toolchain Setup Wizard

The FT9xx Toolchain Setup Wizard has completed successfully. Click Finish to exit the
Setup Wizard. A quick start guide for using the toolchain is induded in the application
notes AM_325. For more information, as well as the latest updates, please visit
Bridgetek's website at www.brtchip. com.

¥ Open AN_325

Figure 17 FT9xx Toolchain Setup Completion Dialog box
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After the installation, the toolchain can be found in the installation directory. The default location is
“C:\Program Files\Bridgetek\FT9XX Toolchain” for 32-bit Windows and “C:\Program Files
(x86)\Bridgetek\FTOXX Toolchain” for 64-bit Windows. This directory also contains the external
utilities needed. The FT9xx drivers, sample applications and documents (if selected for installation)
can be found in "My Documents\Bridgetek\FT9xx".

2.1.1 Installing Java Runtime Environment Manually

The toolchain requires the Windows MSI Installer (msiexec.exe) while installing the Java Runtime
Environment (JRE). The MSI installer can only process one installation at a time. Under some
conditions, msiexec.exe may have already been started by another Windows process during
automatic Windows Update for example. If the installer detects another instance of msiexec.exe
running in the background, the user will be prompted to either wait for the background MSI
Installer to complete and retry after 5 seconds or to skip the JRE installation entirely. This is
shown in Figure 18.

"% FToxx Toolchain Setup [=Ta] x ]|
Installing % -
« Bridgetek

Please wait while the FT9xx Toolchain is being installed.
ERIDGING TECHNBLAGY

-
’0
*

% FT%x Toolchain Setup l—'m""

I.-"'_"‘-.I Setup has detected another instance of Windows MSI Installer
WY (msiexec.exe) running. Setup requires the Windows MSI Installer to
~ install the Java Runtime Environment (JRE) but it is unable to proceed

because msiexec.exe is already used by another process,

Click Yes to wait 5 seconds to retry JRE installation or Mo to skip. JRE
may also be installed separately from the following URL
http:///www.oracle.com/technetwork/java/javase/downloads/jrel-dow
nloads-2133155. html

Please install the 32-bit version (jre-oce-windows-i586.exe)

< Back | | Mext = Cancel

— 41

Figure 18: MSI Installer is busy

If the user skips JRE installation, JRE can be installed manually from the Oracle Website
(http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html) or by
re-running the FT9xx Toolchain Installer later. Please ensure to install the 32-bit version of JRE
(jre-xxx-windows-i586.exe) as the Eclipse installed as part of the FT9xx Toolchain install is 32-bit.
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2.2 Verifying the installation

1. Open a Command Prompt window by typing "cmd” in *Windows Start button > Search box”.
2. Type “ft32-elf-gcc --version” in the command prompt. It should give the following message:

ft32-elf-gcc (GCC) 7.0.0 20161219 (experimental)

Copyright (C) 2016 Free Software Foundation, Inc.

This is free software; see the source for copying conditions. There is NO

warranty; not even for MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

If this message appears, then the toolchain has been successfully setup.
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3 Quick Start Guide: From creating to getting your
application to run on the FT9xx MCUs

This chapter guides you through the steps to create a new application, compile and program it into
the chip. To debug your application, please refer to chapter 4 - “Setting up Eclipse for Debugging”.
For more information about the tools, as well as the advanced features, refer to chapter 5 -
“Advanced Topics”.

3.1 Creating a new project

Double click on the icon “Eclipse for FT9xx" to launch the Eclipse IDE.

Figure 19 Eclipse for FT9xx Icon

When you run Eclipse for the first time, it will ask you for the location of the workspace. Eclipse
will create some files within this directory to manage the projects. Specify a folder of your choice
and click OK.

= Workspace Launcher Iﬁ

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Cheoose a workspace folder to use for this session.

Workspace: | - Browse...

["] Use this as the default and do not ask again

Figure 20 Eclipse Workspace Selection

Note: The following message will be displayed if an existing workspace, which was created by an
older version of Eclipse, is specified. As there may be some configurational changes in files related
to workspace in the newer version of Eclipse which may cause issues, it is recommended to create
a new workspace and imported the existing projects there.
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& Clder Workspace Version ﬁ

Workspace 'Ci/workspace’ was written with an older version of the product and will
be updated. Updating the workspace can make it incompatible with older versions of
the product.

Are you sure you want to continue with this workspace?

[] Do not warn again about workspace versions

Ok l [ Cancel

S ————————————————————————————

Figure 21 Eclipse Workspace Update

To create a new C project in Eclipse, on the menu bar click “File > New > C Project”. The C
Project wizard will open.

Give a name to the project, for example “Hello World”. By default, the new project will be created
inside the workspace you have chosen. If you want to change it, uncheck the box “Use default
location” and specify another location. Choose “Empty Project” for the project type and
“"Bridgetek FT9xx GCC"” for the toolchain. This ensures all the relevant FT9xx include files are
part of the project. Click Next.

[ ™
= C Project [‘:' =] éj

C Project p—

Create C project of selected type

Project name:  Helle World

Use default location

I ChworkspaceHello World Browse...
| default
| Project type: Toolchains:
4 [= Executable Bridgetek FT%ax GCC
I @ Empty Project Cross GCC
@ Hello World ANSI C Project Cygwin GCC

> [= Shared Library
> [= Static Library

I > [= Others
> [= Makefile project
I > [= GMNU Autotools I

Show project types and toolchains only if they are supported on the platform

Figure 22 C Project Wizard
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In the next window, select FT900 _* configurations if your project is to target FT900 series of MCU
or FT930_* to target FT930 series, or both if you wish to target both series and click Next.

[ = C Project l (Sl e |

Select Configurations =

Select platforms and configurations you wish to deploy on

Project type: Executable
Toelchains: Bridgetek FT9xx GCC

Configurations:

l % FT200_Debug Select all
53 FT900_Release

I %) FT930_Debug Deselect all

I35 FT930_Release

I Advanced settings...

Use "Advanced settings” button to edit project’s properties.

Additional cenfigurations can be added after project creation.
Use "Manage configurations” buttens either on toolbar or en property pages.

® e[ e

e

Figure 23 Project Wizard - Build Configurations Selection

The last window is for the toolchain prefix and location. By default, the values will be prefilled as
follows.

FT90x cormpiler prefie  ft32-elf-

FT90x compiler path: | C:\Program Files (x86)\FTOIVFT90x Toclchain\tocls\bin | | Browse...
Figure 24 C Project Wizard - Toolchain Details

Click Finish to complete the New Project Wizard. A new FT9xx project will be created in Eclipse.

3.2 Building the project

After the wizard completes, some folders and an empty source file (main.c) will be created.

18

Product Page
Document Feedback Copyright © Bridgetek Pte Ltd


http://brtchip.com/m-ft9/
mailto:docufeedback@brtchip.com?subject=Document%20Feedback:%20AN_325%20Version%201.04

TECHNOLOGY

 Bridgetek

Application Note

AN_325 FT9xx Toolchain Installation Guide

Version 1.04

Document Reference No.: BRT_000116 Clearance No.: BRT#074

File Edit Source Ref:

-

® -

[y Project Explorer 3

4 |l=5 Hello World
* [al Includes
¢ = Includes
» [= Scripts
4 [ Sources

- € main.c

Figure 25 New empty project structure

The main.c contains some default content:

#tinclude <stdint.h>
#tinclude <ft900.h>

#if defined(___FT900_ )
#define GPIO_UARTO_TX
#define GPIO_UARTO_RX
#elif defined(__FT930_ )
#define GPIO_UARTO_TX
#define GPIO_UARTO_RX
#endif

void main(void){

/* Enable the UART Device...

48
49

23
22

*/

sys_enable(sys_device_uarto);
/* Set UARTO GPIO functions to UARTO_TXD and UARTO_RXD... */
gpio_function(GPIO_UARTO_TX, pad_uarté_txd); /* UARTO TXD */
gpio_function(GPIO_UARTO_RX, pad_uarté_rxd); /* UART@ RXD */

uart_open(UARTO,
1,

/*
/*

UART_DIVIDER_19200_BAUD, /*

uart_data_bits_8,
uart_parity_none,
uart_stop_bits 1);

/*
/*
/*

/* Print out a welcome message... */

uart_puts (UARTO,

"Hello World! \r\n"

/* Now keep looping */

while (1);
}

Device */

Prescaler = 1 */

Divider = 1302 */
No. Data Bits */
Parity */

No. Stop Bits */

Now select the Build Configuration for either FT90x or FT93x via the project menu:
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[Project | Run Bridgetek Utilities Window Help

Open Project v Q v @@ §F v : - -
Close Project

it

| log Build All Ctrl+B B

‘ Build Configurations 4 ‘ Set Active » | v 1FT900_Debug
Build Project Manage... | 2 FT900_Release
Build Working Set 4 Build by Working Set ’ 3 FT930_Debug
S Set Active by Working Set » S e

| ¥ Build Automatically

Manage Working Sets...

Build Targets >
C/C++ Index >
Properties

Figure 26 Build Configuration
This can also be done via the Manage Configurations toolbar icon:
S T R S
iv/ 1 FT900_Debug |
2 FT900_Release

3 FT930_Debug
4 FT930_Release

Figure 27 Build Configuration

Now the project can be built by clicking on the menu Project > Build Project, but note that

|

there are a few options like right-click on the project > Build Project and the icon.

Project | Run  Target Window Help
Open Project |
Close Project

J |y Build All Ctrl+B
Build Configurations r
1 Build Project

Figure 28 Building the Project

The console window at the bottom of the IDE shows the build status. If the build completes
successfully, two files will be created - “Hello World.elf” and “Hello World.bin”. The file to be
programmed into the chip is “Hello World.bin”. The .elf file is used for the debugger, as detailed in
the next chapter.
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|2 Problems 4| Tasks & Console i | [C] Properties

CDT Build Conscle [Hello World]

15:52:13 **** Incremental Build of cenfiguration FT938_Release for project Hello World ****

make all

"Building file: ../Sources/main.c’

"Invoking: FT9xx GCC Compiler’

ft32-elf-gcc -D__FT93@__ -I"C:/Program Files/Bridgetek/FT9xx Tooclchain/Toolchain/hardware/include”™ -0s -Wall -c -fmessage-len;
"Finished building: ../Sources/main.c’

'Building target: Hello World.elf'

"Invoking: FT9xx GCC Linker'

ft32-elf-gcc -L"C:/Program Files/Bridgetek/FT9xx Toolchain/Toolchain/hardware/lib/Release™ -Wl,--gc-sectieons -WL,--entry=_sta:
'Finished building target: Hello World.elf’

"Inveking: FT9xx Flash File Generator'

ft32-elf-objcopy --output-target binary "Hello World.elf" “Helle World.bin™
"Finished building: Helle World.bin'

Figure 29 Build Status

&= workspace - C/C++ - Eclipse [ Project Explorer 53 = I
—

File Edit Source Refactor Navigate S = <-===5| =
Y |®vﬁvn1¢§‘ﬁ§:§ 4 |l=5 Hello World
. - - » g};gp' Binaries

I [mjt Includes

FT900_Deb

f[\jl:'rnject Explorer i3 = “ = --eeu

‘ + == Sources l

&Rl ~ . %5 Hello World.elf - [none/le]

4 |[=5 Hello World [E Hello World.bin
> qf,f' Binaries [ maketiie
> [nyt Includes | & objects.mk
= FT900_Debug

3 | sources.mk

: == FT900_Release 4 [= FT900_Release

: == FT930_Debug + == Sources
» [= FT930_Release v i_} Helle World.elf - [none/le]

. = Includes ™=\ [ Hello World.bin
> [= Scripts | @ makefile
s = Sources | & objects.mk
& sources.mk
4 = F1930_Debug
+ == Sources
» f‘;« Hello World. elf - [none/le]
[E Hello World.bin
@ makefile
| & objects.mk
& sources.mk
4 = FT930_Release

» (== Sources

» (2 Hello World.elf - [nonefle]
[E Hello World.bin
| @ makefile

| & objects.mk

A snnrces mb

Figure 30 List of Files after building (if all 4 configurations were selected)

For syntax highlighting to work correctly as configurations are switched, the C/C++ Indexer must
be configured to “work with the active build configuration”. Refer to section 6.3.3 for more details
on how to do this.
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3.3 Programming the binary file into the chip

The FT9xx Programmer is provided together with the toolchain. There are a couple of options
available.

3.3.1 GUI Version

To run it, double click on the icon “FT9xx Programming Utility” created on your desktop, if selected
during install, otherwise it can be found in:

C:\Program Files (x86)\Bridgetek\FT9xx Toolchain\Toolchain\programmer\dist

Figure 31 FT900 Programming Utility Icon

You can also open the programming utility from Eclipse by selecting it in the Bridgetek Utilities
menu or the toolbar icon as highlighted in Figure 32:

| Bridgetek Utilities | Window Help

@ FT%e Programming WUtility  Ctrl+ Alt+L
&  FT9%x GDE Bridge Ctrl+ Alt+R

Figure 32 Bridgetek Utilities Menu

After the splash message the following screen will appear.
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[ % FToxx Programming Utiity I acon e |
Q Bridgetek

REIDGINE TECANERANET
#

i@ Program via One-Wire interface

(7 Program via USB (DFU) interface
(7 Add/Customize DFU-suffix (DFU binary)

(") Customize Bootloader file

Figure 33: FT9xx Programmer - Work with One-Wire

Select the “"Work with One-Wire” option and click Next. The next screen shows a list of supported
devices that you might wish to program.

When a valid FT900 and Programmer module are detected, the information will be displayed in the
list. Select the device you wish to program and click Next to launch the programmer window.

e T
Interface Q Hl’ingtEk

RELDEINE TECANMRENET

One-Wire
Device Programmer Programmer Serial ...
FT900 UMFTPDZA A FTKIRIESA

Figure 34: FT9xx Programmer - Device Selection

In the programmer window, leave everything as default. Specify the location of the binary file and
click Start. If the Verify check box is selected, an icon will show up next to the status bar to
indicate whether the flash memory has been properly programmer.
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% FT9x Programming Utility g . = o |
{Fizsh &P} p2xx | Data Log | About]|
e < Bridgetek
= Dt b
Interface Target
I One-Wire @) Flash T PM
Binary file
|

Config Address (hex)

[ verify [ Excude bootioader [ Keep existing bootloader

Progress |,

Restore bootloader

Custom (@ Factory ] [

Start

Cancel ]

=

Figure 35 FT9xx Programmer - Flash and PM Screen

More information on the utility can be found in the ‘About’ tab, then click on Help.

3.3.2 Command Line Version

FT900Prog.exe is available to run at a command prompt. Enter FT900Prog.exe to see the options
available. See section 5.1.2 for more details.

This can also be run within Eclipse as an External Tool. See Figure 36 for settings found in Run >
External Tools > External Tools Configurations. The argument string is:

-f "${project_loc}\${config_name:${project_name}}\${project_name}.bin" -0 -v
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£ External Tools Configurations ‘753,
Create, manage, and run configurations @
Run a program @
R IR Name: FT9x Program MTP
type filter text 5] Main RefresH [ob Build | 7 Environment| ] Common |
4 Q, Program Location:
Q, FT9xProgram MTP C:\Program Files (x86)\Bridgetek\FT9xx Toclchain\Toolchain\programmer\dist\FT900Prog.exe

[BrowseWorksp_ace...] [Browsg File System...] [ Variables... ]

Working Directory:

[BrowseWorl_cspace...} {Browse File System...] [ Variables... l

Arguments:

-f "${project_loc}\${config_name:${project_name}\${project_name}.bin" -0 -v -

Note: Enclose an argument containing spaces using double-quotes (7).

7H T "B

Filter matched 2 of 2 items

@ [ Run ] [ Close

Figure 36 FT9xx Programmer in Eclipse

3.4 “Hello World” in action, and more...

The “Hello World” example above will send a message to a serial terminal via the FT9xx UARTO
port. Open a terminal on your computer, for example Tera Term or HyperTerminal. Apply the
following settings:

e Baud Rate: 19200
e Parity Bit: None
e Data Bit: 8

e Stop Bit: 1

e Flow Control: None

Now when you reset the MCU, the message will be printed to the terminal.
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@ F120x - HyperTerminal SRR X
File Ecit View Call Transfer Help
0= & DB

>Hello World!

Figure 37 Hello World

Congratulations! You have just completed your first project for FT9xx. The FT9xx toolchain comes
with plenty of examples, which demonstrate a variety of features. If you have selected to install
them in the Toolchain Installation Wizard, by default they can be found in:

“My Documents\Bridgetek\FT9xx\version\Examples”

The Eclipse project has already been setup for these examples, as suggested by the presence of
two files - “.cproject” and “.project”. Instead of creating a new project, you can simply import
these projects into the workspace. To do this:

wN e

On the Menu bar, choose “File > Import”

In the Import window, choose “General > Existing Projects into Workspace” and click “"Next”.
In the next window, set the root directory to “My
Documents\Bridgetek\FT9xx\version\Examples”. The projects will be detected by Eclipse.
Select which projects you wish to import and click Finish to complete the importing process.
This is an example of how Eclipse would look like with the sample applications. Refer to
AN 360 for more details about these applications.
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£ C/C++ - GIO Example 1/gpio_examplel.c - Eclipse

= = |
File Edit Source Refactor Navigate Search Project Run FIDIUtiliies Window Help
N |- Rv ' N % @G- (-G B0~ wmo g - - = - Quick Access
[ Project Explorer 1% E%| & = 8 [9 gpioeamplelc 3 = B8 I Outline
» (25 ADC Example 1 49 #include <ft9@@.h> -
» £5 ADC Example 2 0

» 5 cam_example 1
> CANEemplel
» {5 CAN Example 2
CAN Ecample 3
> L5 DAC Example
» (5 DAC Example 2
> (5 DAC Example 3
» 5 eth_example_1

4 (5 GPIO Bxample1

#define STR(a) STR_(a)
#define STR_(a) #a

#define GPIO_PIN 18

void setup(void); d
void loop(void); :ﬁsvﬂu‘;?) mc:\

int main(void) main(void) : int

{

ee e T ITHRREE
]
=
s

setup() void
forry loop(): void

» 4 Binaries for(;;) loop();

) Includes , return ;

» & Debug

> €] gpio_examplel.c
» (5 GPIO Example 2
» 5 GPIO Example 3
12C Master Example 1
> (25 12C Slave Eample 1
125 Example 1

void setup()

Enable the UART Device...
sys_enable(sys_device_uarto);

iske GPIOAS function as UARTE_TXD and GPIO49 function as UARTE_RXD
gpio_function(48, pad_uartg _txd); /* UARTG TXD

gpio_function(49, pad_uart® rxd); /* UART® RXD
» &5 S Bample2 uart_open(UART®, Device
» 5 PWM Example 1 g / P’Eizﬂle’
UART_DIVIDER 1920@_BAUD, /* Divider
> 5 PWM EBxample 2 uart_data_bits_§, No. Data Bits L
5= PWM Bample 3 7 uart_parity_none, /* Parity N
> (25 RTC Bampled 7

uart_stop_bits 1);

79

> (5 RTC Example 2

- (35 SD Host Example 1 ) Print out a welcome message.
. 81 uart_puts (UARTE,
i SPLMaster Example 82 \x18[23" /* ANSI/VT100 - Clear the Screen
SPIMaster Example 2 83 "\x1B[H" /* ANSI/VT188 - Move Cursor to Home */
> 5% SPIMaster Example 3 "(C) Copyright 2014-2@15, Future Technclogy Devices International Ltd. \r\n”
» 5 sPISlave cample 1 85 . \rn®
- G5 Timer Example1 86 "Helcome to GPIO Example 1... \r\n"
o gt
> & Timer Example2 "Toggle a pin on and off.\r\n"
» €5 Timer Example3 . -
» 5 uart_sample_1

)5

» 5 vart_example 2
> 5 vart_example 3
» (5 Watchdog Example 1

the
GPIO_PIN, pad_dir_output);

& Console 52 BB |=B~mv=0
CDT Build Console [GPIO Example 1]
TR Tt s
F£32-elf-gec -L"C:/Program Files (x86)/FTDI/FT90x Toolchain/Toolchain/hardware/1ib" -Wl,--ge-sections -Wl,--entry= start -o "GPIO Example 1.elf" ./gpio_examplel.o *
*Finished building target: GPIO Example 1.elf’
*Invoking: FT98x Flash File Generator’
t32-e1f-1d --oformat binary "GPIO Example 1.elf" -o "GPIO Example 1.bin"
*Finished building: GPI0 Example 1.bin'
*Invoking: FT90x Display Image Size’
ft32-elf-size --format=berkeley -x "GPI0 Example 1.elf"
text  data  bss  dec  hex Filename
ex139% ©0x206  Ox1 5527 1597 GPIO Example 1.elf
*Finished building: SIZE'
14:22:36 Build Finished (took 1s.434ms)
‘ i v
(5 GPIO Example 1 H

Figure 38 FT9xx Examples
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4 Setting up Eclipse for Debugging

Eclipse comes with an intuitive GUI for debugging applications. To enable this feature, eclipse
requires additional information about our debugger. The steps are presented below.

4.1 Build the application using the Debug configuration

The application should be built using the Debug configuration so that the debug information is
available. It is the default build configuration but can be verified in the Project menu.

ch | Project | Bun  Bridgetek Utilities  Window Help

P Open Project B ~ [ﬁ - = o v - -
Close Project
ple_2_testing.c &3

oé  Build All Ctrl+B
Build Configurations » Set Active b | v 1FT900_Debug
Build Project Manage... 2 FT900_Release
i i 4
Build Working Set Build by Working Set , 3 FT1930_Debug
Clean... Set Active by Working Set b 4 FT930_Release

v Build Automatically Manage Working Sets...

Figure 39 Build Configuration

Please note for FT93x: As of toolchain v2.3.0 it is recommended to disable the -mcompress
option when using GDB as single stepping does not work properly with -mcompress. The option can
be disabled in the project settings. See section 6.3.2.1 for more details.

4.2 Create a new debug configuration

A debug configuration is used by Eclipse to launch the debug GUI and only needs to be created
once for the FT9xx Debugger. To create it:

On the Menu bar, select Run > Debug Configurations...

In the Debug Configurations window, double click on *"C/C++ Remote Application”

Press the ‘New’ button to create a new debug configuration

In the next window, a Debugging Launcher will need to be specified. Click on “Select others...”
at the bottom of the window.

el NS

Using GDE (D5F) Automatic Remote Debugging Launche Apply Revert
Debug Close

Figure 40 Choosing a Debugging Launcher (1)

5. In the “Select Preferred Launcher” window, check “Use configuration specific settings”. Then
choose “"GDB (DSF) Manual Remote Debugging Launcher”. Click OK.
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[ = Select Preferred Launcher l S )

This dialog allows you to specify which launcher to use when multiple
launchers are available for a configuration and launch mode.

Use configuration specific settings I Change Workspace Settings...

Launchers:

GDB (DSF) Automatic Remote Debugging Launcher

Standard Remote Create Process Launcher

GDEB (DSF) Manual Remote Debugging Launcher |
—

@ [ ok [ canca |

Figure 41 Choosing a Debugging Launcher (2)

6. Now provide the details for the configuration. Specify the name of the Debug configuration,
for example “"FT9xx Remote Debug”. Use this configuration to debug FT9xx projects from now
on.

7. Under Main tab, specify the project and the .elf file for Application. The “Browse...” button
next to the project field will list all active projects. The .elf file can be found easily after the
project has been selected, by clicking on “Search Project...” button.

Mame: FT9x Remote Debug
B Main % Debugger & Source| [] Common
Project:
Hello World
C/C++ Application:
Debug/Hello World.elf

’ Variables... ”Searr_hProject...” Browse... ]

Figure 42 Eclipse Debugging Application Settings

8. Under the Debugger tab, the user needs to provide some Debugger Options. Specify the path
to ft32-elf-gdb.exe (or simply “ft32-elf-gdb.exe”) in the Main sub-tab and make sure the
“"GDB command file” field is empty. ft32-elf-gdb.exe can be located in the toolchain
installation folder, under “tools\bin”.

Name: FT9x Remote Debug
B Main [ %5 Debugger E. Source| ] Commen

Stop on startup at  main

Debugger Options

Main |Shared Libraries Connection|

GDEB debugger: CAProgram Files (xB8)\Bridgetek\FTSx Toolchain\Teolchain\tools\bi
GDB command file:

Figure 43 Eclipse GDB Settings
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9. Under the Connection sub-tab, choose the connection type to be TCP. Enter “localhost” for
the host name and 9998 for the port number.

Mame: FT9x Remote Debug
%] Main | %5 Debugger & Source| 0] Common

| 5top on startup at: main

Debugger Options

| Main I Shared Libraries| Connection

Type: |TCP =

Host name or IP address:  localhost

Port number: 9998

Figure 44 Eclipse TCP Port Settings

10. Click “"Apply” and close the window.

A debug configuration for FT9xx has now been created. To use the same configuration for other
projects, simply open it and select the right project and application, as presented in step 6 above.

4.3 Running the GDB Bridge

The GDB Bridge is needed for ft32-elf-gdb to talk to the MCU. To run it, simply double click on the
desktop icon “"GDB Bridge”.

oy
SH G

lald]
@m ILOOIES

G UGBS

Figure 45 GDB Bridge Icon

You can also launch the GDB Bridge from Eclipse by selecting it in the Bridgetek Utilities menu or
the toolbar icon as highlighted in Figure 46 Bridgetek Utilities Menu

| Bridgetek Utilities | Window Help
@ FT%e Programming WUtility  Ctrl+ Alt+L
&  FT9%x GDE Bridge Ctrl+ Alt+R

Figure 46 Bridgetek Utilities Menu

The following window should appear:
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ESNEERTST)

C:\Program Files (x86>\FIDI\FT?8x Toolchain\Toolchain\utilities>D2XX library loa
ded OK

Figure 47 GDB Bridge in action

Now the tools are ready to debug the application in Eclipse.

Note: User must close this debug GDB script when debugging is finished, otherwise it may not be
possible to program the device for example.

4.4 Debugging the application in Eclipse

1. Open the debug configuration that was created (FT9xx Remote Debug) and click Debug. Note
that this will appear in the Debug button on the toolbar after running once.

Name: Hello World.elf
[£] Main (9= Arguments| B Environment | %3 Debugger| % » Source| [T] Common

Project:
Hello World [ Browse.. |
C/C++ Application:

FT300_Debug/Helle World.elf

Variables... | |Search Project...| | Browse.. |

Build (if required) before launching

Build Configuration: | FT900_Debug v|

Enable auto build Disable auto build

o) Use workspace settings Configure Workspace Setfings...

[ Debug | Close

Figure 48 Eclipse Run Remote Debugging

2. The Debug perspective will be opened. The execution will stop at the first line in main(), as
shown below. Various debug commands (step into/over, resume, halt, stop, etc.) can now be
accessed from the toolbar via buttons. Function variables, setting breakpoints and viewing
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physical memory in the memory tab, along with some other debug features are also available
now.

& Debug - Hello World/main.c - Eclipse Platform = | B S|
File Edit Scurce Refactor Mavigate Search Project Run  Window Help
m @lEEIND I ENDE D B S MU R Rl 1. Bs i
% - ﬁ A = = Quick Access s | I Resource %CJ’CH—
i - = \= =
% Debug 52 | i O (%= Variables 52 =
4 [T] FT90x Remote Debug [C/C++ Remote Application] = ‘ et |
5 = L1
4ty Hello World.elf Name iType Value

4 f Thread #1 (Suspended : Breakpoint)
= main() at main.c:12 0x2f8
s Ci/Program Files (x86)/FTDI/FT90x Toelchain/tools/bin/ft32-

« I v
f [T ol |2 {5
main.c % main.c = H 9% Outline 53 = "

o
& * main.c i =) laz w \s o % v
- '
#include <stdic.h> = stdic.h

@ main(void) : int
= int main(void)

m

1
printf("Hello World!\n");
While (L1);
return 8;
} -
4 [}
& Console &2 ] |5x‘E|E||="E'i=J'='E|

FT90x Remote Debug [C/C++ Remote Application] C:/Program Files (x86)/FTDI/FT90x Toolchain/tools/bin/ft32-elf-gdb.exe (7.9.50.20150310)
Find the GDB manual and other documentation resources online at:
<http://www.gnu.org/software/gdb/documentation/>.

For help, type "help".

Tvpbe "apropos word" to search for commands related to "word". i
4

Writable Smart Insert 12:1

Figure 49 Eclipse Debug Environment

Note: If there is an error message about missing source file as below, locate the source file that
contains the main() function using the “Locate file...” button.

Locate the file or edit the source lookup path to include its location.

View Disassembly...‘

Locate File...

Edit Source Lookup Path... ‘

Figure 50 Eclipse Missing Source File

4.4.1 Watch variables in Eclipse Debug Perspective

If the watch variables fail to update or display incorrect values, check that the following flags exist
for the debug build (they are present by default in all projects created with Bridgetek eclipse
plugin)

-fvar-tracking -fvar tracking-assignments
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Configuration: ’FFQUU_DEHUQ [ Active ] "] ’Manage Configurations...

& Tool Settings |.ﬁ" Build Stepsl Build Artifactl Binary Parsersl €3 Error Parsers|

(& FT9x Toolchain Settings | Debug Level | Default (-g) -
@ Target Board
(% FT32B Options

Other debugging flags  -fvar-tracking -fvar-tracking-assignments

4 B FT%u GCC Compiler [ Generate prof information (-p)
(# Dialect [ Generate gprof information (-pg)
(2 Preprocessor [ Generate gcov information (-ftest-coverage -fprofile-arcs)

(# Includes

(# Optimization
@ Debugging
@ Warnings

R b oar "

Figure 51 Debug flags

4.4.2 Og Compiler Option when debugging

When compiling a project with no optimization (or —-0O0) some useful debugging information may
not be generated at all, leading to possible unexpected results while debugging. To avoid this, it is
recommended to turn on -0Og option when no other optimization flags are used. The Bridgetek
eclipse plugin does this automatically.

Note that if multiple optimization options are used, only the last option will be effective.

Configuration: ’FFQUU_DEbug [ Active ] '] ’Manage Configurations...

& Tool Settings | 44 Build Steps | Build Artifactl Binary Parsers | & Error Parsers|

(% FT%x Toolchain Settings Other optimization flags  -Og
(% Target Board
(# FT32B Options

4 B FT9oc GCC Compiler
A5 Mialert

Figure 52 Og compiler optimization option

More information can be found in the GCC documentation -
https://gcc.gnu.org/onlinedocs/gcc/Debugging-Options.html and
https://gcc.gnu.org/onlinedocs/gcc/Optimize-Options.html

4.5 Eclipse features supported by ft32-elf-gdb

At the moment, not all features of the Eclipse debug perspective are supported by ft32-elf-gdb.
The current list of supported features is:

Breakpoint creation.

Single stepping/stepping in/stepping out of functions
Watch variables

Assembly instruction stepping
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5 Bridgetek Projects

Besides the empty project used as the example in Chapter 3, there are several project types
specific to Bridgetek. They can be found under “Others” in the project type selection window.
Currently, there are two project types:

e D2XX Project
e Data Log (DLOG) Project

For more details about these project types, refer to "AN_360 FT900 Example Applications”, which
is included in the toolchain installation.

Project type: Teolchains:

4 [= Executable Bridgetek FT9:x GCC
& Empty Project
@& Hello World AMSI C Project
> 2= Shared Library
» == Static Library
4 = Others
£» FT%hoc D2XX Project
<» FT9u Data Logger Project
+ = Makefile project
» = GNU Autotools

Figure 53 Bridgetek Project Types
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The procedure to create a new project is similar to the empty project. When the wizard completes,
a template source file will be generated. Below is the template generated for the D2XX project.

[€] main.c [€] main.c &2 = 0
127 loop(); -
128
129
13e /* Event handling */

131 if (D2XXTEST_ Dfubetach)

132 {

133 delayms(18@);

134 /* DFU detach request had come. Exit D2XX */

135 D2XX_Exit();

136

1375 /* Take the system to DFU Mode. Provide timeout in mg to

138 * wait for re-enumeration with the host

139 R

140 STARTUP_DFU(@);

141 break; £
142 1 1
143

144 /* suspend mode handling */

145 if (DIXXTEST_ Suspend)

145 {

147

148 wkupScurce = @3

143 dbg(“Entering Suspend Mode at Master \rin");

150 delayms(1e@);

151 #ifdef GPIO_REMOTE_WAKEUP

152 SetRemotelakeup = @;

153 if (RemotelakeupEnable)

154 {

155 dbg("Configuring GPIO pin to wakeup \r\n");

156 #if 1

157 /* Set up the pin */

158 gpio_dir(GPIO_PIN, pad_dir_input);

159 gpio_pull(GPIO_PIN, pad pull pullup);

160

161 /* Attach an interrupt */

162 gpio_interrupt_enable(GPIO_PIN, gpio int edge falling);

163 interrupt_attach{interrupt_gpio, (uint8_t)interrupt_gpio, ISR gpio);
164 dbg("D2XXTEST: GPIO pin setup for interruptirin”);

165 #endif

166

167 #endif i

< | [ »

Figure 54 D2XX Project Template

The template can be compiled as it is but additional code is needed to customize it according to
the user’s need.

[£] main.c [ main.c i el 3 f outine

127 loop()s File Edit Source Refactor MNavigate Search Project Run  FTDIUtilities Window Help
128

120 o SRR RS ATER UL P RN E AR CRSE TR P R B A N SY Nl SR u
138 /* Eventfil . - - . o 7
131 if (52 o B e Quick Access @l# Debug

u
u
132 - [
33 { dela [ Project Explorer 532 main.c €] main.c &1 =0 gon > = g - .::
134 /* ] == Loop(); sEEBRY ¢ | u
135 D2XX -
1o + 5 Hello World - - =t
1372 /* T 4 [ TestD2XX /* Event handling */ =] stdint.h #
138 * W . # Binaries if (D2XXTEST_ Dfubetach) u #
138 * 3 + il Includes { ) ) B hneh #
ﬁj ETAR + [ Debug < m | « [Lm ] s #
rea
#
#
@
@5

Includes
142 3 & [ P c =
s , & Scripts #. Problems J=| Tasks [ Console % [C] Properties B8

144 /* Suspe 4 = Sources @ G | '—E Eﬁ - E’“ ™ = g -
145 if (D20 > 8 ert0s COT Build Console [TestD2XX] b
146 { . |8 mainc o - #°D
D
D

string.h

1;; wkup! 'Building target: TestD2XX.elf' &Y

149 dbg( 'Inveoking: FT98x GCC Linker' | sy

158 dela ft32-elf-gcc -nostartfiles -L"C:/Program Files/FTDI/FT98x Toolchain/Toolchain/hardware/.
'Finished building target: TestD2XX.elf'

152 SetRé
153 if (
154 {
155

156

157

'Inveoking: FT98x Flash File Generator' ®°D
ft32-elf-objcopy --output-target binary "TestD2XX.elf" "TestD2XX.bin" &V
'Finished building: TestD2XX.bin'

=

'Invoking: FT98x Display Image Size'|

158 ft32-elf-size --format=berkeley -x "TestD2XX.elf"

159 text data bss dec hex filename
@a3ebee Bx434 @x2284 266334 41284 TestD2XX.elf

168 ax3eb 434 ‘

162 o n
163
164
165
166
167 #endif

se e TTTTTTT
=3

4 | I » 4|

Figure 55 Compiling D2XX Template Code

35

Product Page
Document Feedback Copyright © Bridgetek Pte Ltd


http://brtchip.com/m-ft9/
mailto:docufeedback@brtchip.com?subject=Document%20Feedback:%20AN_325%20Version%201.04

Application Note

»
K> - AN_325 FT9xx Toolchain Installation Guide
..< Bl‘ldg&tek Version 1.04
.0

BRIDGING TECHNOLOGY
Document Reference No.: BRT_000116 Clearance No.: BRT#074

6 Advanced Topics

6.1 Running the toolchain from the command prompt

6.1.1 Compiling the sample applications using a Makefile

The FT9xx GNU toolchain can be used to compile source code from a command prompt in the
same way the official GNU Toolchain is used, often with the help of a Makefile or a batch file.

The sample applications are available in "My Documents\Bridgetek\FT9xx\Examples\ if you have
installed them using the installation wizard.

NOTE: makefiles are not included with the toolchain installer.

6.1.2 Programming a binary file into the chip

The programmer can be found in the folder “programmer\dist” in the program installation directory
(C:\Program Files (x86)\Bridgetek\FT9xx Toolchain). The command line programmer is
FT900Prog.exe. The toolchain is provided with a default bootloader. The bootloader is located at
the top 4 KB of the flash memory (address 0x3F000 to Ox3FFFF). At boot, the FT9xx resets and
executes instruction at 0x00000, jumping into the bootloader. The bootloader then performs the
initializations needed and jumps to location 0x8c, which is the start of the user program. The
bootloader is also needed to support debugging with the FT9xx port of GDB.

1. Run the tool FT900Prog.exe without any arguments, the options and usage will be printed.
They will also be printed if the specified options are not valid. The most common usage is
programming a binary file through the one-wire interface with the supplied bootloader. To do
this, the command is:

FT900Prog.exe -f <.bin file with path if needed> -O
in which the options are:

-f: programming the binary file into the flash. The path to the binary file must follow.
-O: using the one-wire interface.

If you want to verify the content of the flash memory after programming, specify “-v” in the
command:

FT900Prog.exe -f <.bin file with path if needed> -0 -v

2. If the bootloader is not required, option “-x” can be specified, in which case the program will
start executing from address zero and the command is:

FT900Prog.exe -f <.bin file with path if needed> -0 -x

The supports for GDB debugging will not be available however.
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6.1.3 Debugging the sample applications with ft32-elf-gdb

1. The applications must to be compiled with -g option (i.e. ft32-elf-gcc -g ...). An .elf file will be
created which includes the debug information, for example GPIO/gpio_examplel.elf. Note that
this file is not used for programming the chip.

Note: If the output file name for the linker is not specified in the Makefile (i.e. option -0 is
missing), a.out will be created instead of an .elf file. They are the same and these steps can be
applied to a.out as well.

2. Flash the .bin file into the chip. Refer to section 5.1.2 above.

3. Open a command line window, run:
“python <Installation directory>\Toolchain\utilities\gdb_bridge.py live”

Note: An alternative is to double click on the shortcut “GDB Bridge” created after the
installation.

The correct response should be:

R R o e

C:\Program Files (x86)>\Bridgetek\FI2xx Toolchain\Toolchain\utilities>D2XX librar
y loaded OK

Figure 56 FT9xx Debugging Status

Note 1: If there is an error message about permission being denied, the command line
window may need to be opened with administrator rights by right-clicking and selecting ‘Run
as administrator’.

Note 2: It is also possible to run the GDB Bridge using the shortcut created after the
installation.

Note 3: If the path to gdb_bridge.py contains spaces, enclose it with double quotes (*”).

4. Open another command line window, go to the folder that includes the .elf file, run “ft32-elf-
gdb <.elf file>", for example “ft32-elf-gdb gpio_examplel.elf”.

5. After ft32-elf-gdb starts, type in “target remote localhost:9998” to establish a connection to
the MCU.

6. Use standard GDB commands to debug the program. Note that the command to start
execution should be “continue”, not “run”.

6.2 Installing Eclipse and the FT9xx plugin manually

When running the installer, it is possible to choose not to install Eclipse as part of the installation.
This might be useful if the user have already installed Eclipse for other purposes. This section
details how to set it up for use with the FT9xx.
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6.2.1 Eclipse Installation

1. Go to Eclipse website, download “Eclipse IDE for C/C++ Developers”. At the time of this
writing, Eclipse Mars is the latest release and is the recommended version.

2l Windows
& 166 MB 1,144,540 DOWNLOADS
LS 3 \
The essential tools for any Java developer, including a Java IDE, & Git client,
XML Editor, Mylyn, Maven integration and WindowBuilder...
ﬁ Windows
(o
T 176 MB 449,358 DOWNLOADS 3
L5 = \
An IDE for C/C+ developers with Mylyn integration.
A Windows
— 244 MB 297,100 DOWNLOADS 3
- =) \
Package suited for development of Eclipse itself at Eclipse.
Windows
— 153 MB 281,587 DOWNLOADS nee
@ & \
The essential tools for any PHP developer, including PHP language suppart,
Git client, Mylyn and editors for JavaScript, HTML, CS5 and...
Windows
2 296 MB  170.55% DOWNLOADS neew
-7 & |

The essential tools for Java and DSL developers, including a Java & Xtend
DE, a DSL Framewark (Xtext), a Git client.

Figure 57 Eclipse Versions

2. When Eclipse is run for the first time, it will ask for the workspace location.

= Workspace Launcher &J

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

Workspace: hd Browse...

["] Use this as the default and de not ask again

Figure 58 Eclipse Workspace Location

A workspace is a directory on the hard drive where Eclipse stores the projects defined to it.
More specifically, a workspace is a logical collection of projects. When you specify this
directory name to Eclipse, Eclipse will create some files within this directory to manage the
projects. The projects controlled by this workspace may or may not reside in this directory.
Specify a directory name and click OK.
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Note: To run Eclipse, it is required to download and install the Java Run Time Environment
(JRE) or Java Developer Kit (JDK). Eclipse should display a warning if this is not installed.
Oracle provides these tools for free.

6.2.2 FT9xx Eclipse Plugin Installation

To assist with completing the configuration of Eclipse for FT9xx coding an extra plug-in is provided
as part of the download. To install the plug-in the following steps are required:

1. From the Eclipse toolbar select Help -> Install New Software which will pop up the window as
below.

Available Software
. . . J
Check the items that you wish to install. :)i

Work with:  Bridgetek - files, ‘com.ftdichip.f90x/ -

Find mere software by working with the "Available Software Sites” preferences,

type filter text

Mame Version
> (00 Bridgetek FT9x« Eclipse Plugins

Select All | | Deselect Al

Details

Show only the latest versions of available software Hide items that are already installed
Group items by category What is already installed?

[] Show only software applicable to target environment I
Contact all update sites during install to find required software

@ < Back Next > Finish

Figure 59 Eclipse Plugin Setup Wizard

2. Select the ADD button, and browse to the LOCAL location of the folder ‘com.ftdichip.fto0x’
which can be found in “Toolchain\eclipse plugins” in the toolchain installation directory.

3. Press “SELECT ALL” followed by NEXT to install the plugin

4. Close the window when complete.
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6.3 Common project settings in Eclipse

6.3.1 Include paths

Eclipse uses its built-in indexer to resolve dependencies between files. In order for the indexer to
work correctly, paths that contain the header files in the project need to be added as follows:

1. Right-click on the project and select Properties

2 C/C++ - FTO0x_Examples/GPIO/gpio_examplel.c - Eclipse =0 () S
File Edit Source Refoctor Mavigate Search Project Run Window Help
e [ ® >R~ @min! B RAARAEENCRIE R RA PRI Ro=1 ek SRR A Ciw | e
Quick Access || B | [EEC/Cer ] % Debug
[i5 Project Explorer 57 = A = 8 fSach B ‘= =8 i
2% - = A § 2
4[5 FTO0x Exgonnloc 2 = No search results avsilsble. Starta  (5)
+ ) Includ New > search from the search dislog.. —
> B3 ADC GoInte
. = Came
& caN Open in New Window
) & DAC | [ Copy Ctrl+C
@ Bhen = o
;& GPIO aste trl+V I
, @ RCM ¥ Delete Delete =
» @ 2CS| & Removefrom Conted Ctrl+Alt+ Shift+ Down
> &2 Source »
B lib Move...
> & PWM
& RTC Rename... £2
Ty Impott
gzo. 1 4 Export..
El
S5 pildProject
u f900.h
_: i Clean Project I
# GPIOF &) Refresh [
# STR) Close Project
: ‘STR,(O Close Unrelated Projects Bl Console 2 R GHEEE #B-rt-= 0o
oop(v
o loop0 Build Configurations » fation] C:\FT900\toolchaim programmen dist\FT900Prog.exe (26/1/15 5:56 pm)
© maint  Make Targets [ S =
+F setup(y Index » g Utility!l!
e sewpd PRI
Show in Remote Systems view
Profiling Tools v
Convert To
A
v
Profile As L 2
Debug As v
. Run As »
5 FT90x Example,
L~ = " CompareWith >
Restore from Local History..
#7 Run C/C++ Code Analysis
Team »
| Propeties Ales Enter |

Figure 60 Eclipse Project Properties

2. In the Properties window, select C/C++ General > Paths and Symbols
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= Properties for hellowarld l (S0 | S
type filter text Paths and Symbols - v
» Resource
Builders
. C/Cs+ Build Configuration: [Default [ Active ] v] [Manage Conﬁgurahons...l
a C/C++ General
: Code Analysis
Dacumentation (5 Includes | # Symbols | = Libranasl B Library Pathsl [ Source Location | (=% Qutput Location | i [
File Types
Formatter Languages Include directories Add...
Indexer Assembly i
Language Mappings GNU C dit...
Paths and Symbols GNU C++ Delete
Preprocessor Include Pz
Profiling Categories Export
Project References
Run/Debug Settings.
y Move Up
> Task Repository
WikiText Move Down
(D) "PreprocessorInclude Paths, Macros etc.” property page may define additional entries
Show built-in values
[ £ Import Settings... ] [ S Export Settings...
. S . Restore Defaulis| [ apply |
@] [ OK l [ Cancel ]

Figure 61 Eclipse Paths and Symbols

3. Under the Includes tab, choose "GNU C” under Languages, then click “Add...” on the right
side of the window

4. In the “Add directory path” window, specify the path to the folder that contains the header
files. If the same path is used for some C++ files, check the box “Add to all languages”,
then click OK.

8 " Add directory path @

Directory:

[] Add to all configurations

[] Add to all languages
[[] = Is a workspace path

Figure 62 Eclipse Add Directory Path

Note: The paths should be added one at a time. The use of semicolon is not supported.

6.3.2 Toolchain settings

The FT9xx toolchain supports most GNU toolchain options. To specify an option that is not included
by default, for example to create a map file, do it as follows:
1. Right click on the project and select Properties

2. In the Properties window, select C/C++ Build > Settings. The toolchain settings can be
adjusted in the Settings window.
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type filter text

> Resource
Builders
4 CfC++ Build
Build Variables
Environment

Settings = S

Configuration: lF@UU_Debug [ Active ] '] [ManageCanigurations...

(& oo T

@

Logging B Tool Settings ‘ # Build Steps | Build Artifact | Binary Parsers | @ Eror Parser;|
Settings
Tool Chain Editor (3 FTt Toolchain Settings Command:  gec
g el
> C/Cr+ General % Target Board All options:  .D_FT900_ -I'C:/Program Files (86)/FTDL/FT30x =
Linux Tools Path (22 FT328 Options Toolchain/Toolchain/hardware/include” -Og -g -
Project References a B FT9ec GCC Compiler fwar-tracking -fvar-tracking-assignments -Wall -c -
Run/Debug Settings @ Dialect fmessage-length=0 -ffunction-sections
> Task Repository @ Preprocessor
Task Tags @ Includes
| > Validation (# Optimization Expert settings:
. T .
WikiText (% Debugging Command /e o AND] S{FLAGS} S{OUTPUT_FLAG) S{OUTPUT_P
I (& Warnings line pattern:

(E Miscellaneous
By FT%0c GCC Linker
@ General
@ Libraries
@ Miscellaneous
(& Shared Library Settings
B FT%0c GCC Assembler
& General
a 53 FT% Flash File Generator
@ General
a4 B3 FT%o Display Image Size
@ General

[

Y

4 1

[ Restore Defaults ] [ Apply

]

[ ok

J{

Cancel

]

6.3.2.1

Figure 63 Eclipse Toolchain Settings

FT32B options (only for FT93x)

The FT93x target has two special compiler options -mft32b and -mcompress. -mft32b enables the
FT32B instruction set and -mcompress enables code compression, which can typically result in a
code size reduction of about 20 - 30%. These options can be updated in the toolchain settings as
shown in Figure 64. Note that this option is only available in the FT930_* configurations.

type filter text

> Resource
Builders
a4 CfC++ Build
Build Variables
Environment
Legging
Settings
Tool Chain Editor
5 C/C++ General
Linux Tools Path
Project References

Settings

- -

Configuration: l FT930_Debug

'] [Manage Configurations...

B Tool Settings |,ﬁ‘ Build Stepsl Build Artifactl Binary Parsersl @ Error Parsers|

FT32B Instruction Set (-mft32h)
Code Compression (-mecompress)

(22 FT%e Toolchain Settings
(22 Target Board
@ FT32E Options

4 33 FT9oc GCC Compiler

Figure 64: FT32B options (for FT93x)
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6.3.3 C/C++ Indexer Settings

For eclipse syntax highlighting to work correctly as you switch configurations, the Indexer has to
be configured to work with the active build configuration as shown in Figure 65. This is a
workspace specific setting and can be accessed in eclipse via Window | Preferences | C/C++ |
Indexer

type filter text Indexer - vy v
> General
a C/C++ [¥] Enable indexer
Appearance Indexer opticns
> Autotools Index source files not included in the build
> Build
CUId Analvsi [¥] Index unused headers
ode Analysis
. Code Style [ Index all header variants
. Debug Index all variants of specific headers:
- Editor
?l: Types ["]Index source and header files opened in editor
ndexer
[¥] Allow heuristic reselution of includes

Language Mappings

» Mew C/C++ Project Wi Skip files larger than: 8 MB
+ Profiling Skip included files larger than: 16 ME
> Property Pages Settings . . .
Task Tags [] Skip all references (Call Hierarchy and Search will not work)
Template Default Value [7] Skip implicit references (e.g. overloaded operators)
Changelog [] Skip type and macro references (Search for these references will not work)
> Help
. Install/Update Indexing strategy
> Library Hover [¥] Autematically update the index
> Mylyn Update index immediately after every file-save
> Oomph
> Remote Development
|| 1 Remote Systems @ Use active build configuration
» RPM () Use the build configuration specified in the project's indexer settings
> Run/Debug |
> Team Cache limits
: Tra.cmg- Index database cache:
;:;f ation Limit relative to the maximum heap size: 10 %
’ Absolute Limit: 25 MB
Header file cache (used by refactoring):
Absolute Limit: 64 MEB
P —T— > [Restore Defaults] [ Apply ]
@' @j [ OK l ’ Cancel ]
L - 4

Figure 65: Configure eclipse indexer to use the active build configuration
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7 Troubleshooting

This section documents the problems you may encounter when using the FT9xx toolchain.

7.1 Makefile error

If using a makefile to build an application, some makefile errors may be reported, for example:

E¥ Command Prompt |£|E|ﬂ—hj

Figure 66: Makefile Error

This is usually because some existing toolchain on the system may be using its own “make” utility
which is also referred to in the PATH variable. The FT9xx examples need to be built by the
GnuWin32 “make” utility, which can be installed during the toolchain installation. To solve this
problem, adjust the PATH variable so that the correct "make” utility is called by the toolchain. Note
that it may be necessary to adjust PATH again for the other toolchain. Type “where make” in a
command prompt to find out which “make” utilities are present on the system.

E® Command Prompt |ﬂlﬁ

am Fil
18611¢

Figure 67 "make" Locations
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Appendix A - References

Document References
http://brtchip.com/m-ft9/

TN_160 Eclipse Projects

Acronyms and Abbreviations

Terms Description
CMD Command-line interface
DLL Dynamic-link Library
DLOG Data Log (Project)
GAS GNU Assembler
GCC GNU Compiler Collection
GDB GNU Project Debugger
GNU GNU (Gnu's Not Unix) Operating System
GUI Graphical User Interface
IDE Integrated Development Environment
JDK Java Development Kit
JRE Java Runtime Environment
MCU Microcontroller Unit
PATH PATH Environment Variable
TCP Transmission Control Protocol
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